RENESANS Application Note

RX Family

Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample
Code

Introduction

This application note describes sample software for data acquisition for Reality Al. Acquired data is
converted into any files using Reality Al Data Storage Tool on PC.

Target Device
RX Family MCUs
. Operation confirmed MCU: RX65N

When using this application note with other Renesas MCUSs, careful evaluation is recommended after making
modifications to comply with the alternate MCU.
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

1. Data acquisition for Reality Al
Follow the steps below to collect data for Reality Al.

. Signal data such as sensors are stored in memory by Data Collector.
. The stored data is sent to the PC Data Shipper.
. Data Storage Tool running on a PC converts it into a file and uploads it to Reality Al.

Reality Al analyzes uploaded data and generates source code. Please see the e2 studio
documentation for information on how Reality Al and e2 studio work together.

The following diagram is the system structure.

Evaluation Board PC Windows Web Service
MCU .
Data Shipper e2 studio Reality Al Tools
|DTC|| SCI || UART H» USB Serial |# Data Storage Tool e
Sensor = L
ata Lollector K 'Y
_— File | FTFile
(CSV) [] (WAV)

1.1 Overview of Data Collector
Data Collector collects data such as sensors in memory. There are two ways to collect it.
. Snapshot
Data is collected using a timer provided by the Data Collector.
. Data Feed
Data is collected using a timer provided by the user.
After collecting a specified number of data, it calls the Data Shipper’'s API.
1.2 Overview of Data Shipper
Data Shipper sends data stored in memory by Data Collector to the PC via UART.
UART settings are set in “UART Communication Driver Interface Middleware”.
1.3 Overview of Data Storage Tool

Data Storage Tool convert file from sent data by Data Shipper.
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RX Family

Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

Start new capture

8 o X
B% Reality Al Data Storage Toal X =g
"
Project: | DC_DS_TST w
Status Settings
1., Mo data
- Data connection... Data file settings... L 34 ST
Data capture Signal view
Frame size: Ch Mame ~
'I;\Iumber = . dcO_snapshot_ch0
rames per file:
[ Unlimited dcO_snapshot_ch1
dc0_snapshot_ch2
Instance ID: E . P &7
[/ € >

(®) Auto scale view

(O Fixed scale view

O Liveview (@) File review 256 samples
Manage capture data files
Data file group Data file Create date Size Class name Status Coli Refresh
metadata.csv myClass_20230... Wed Jul0502... 143KB yourClass GOOoD Blui
Select all data
myClass_20230.. Wed Jul050%... 146KB myClass GOOD Red
myClass_20230... Wed Jul 05 14.6 KB myClass GOOD Yell Copy data to group...
myClass 20230... Wed Jul 0509... 147KB myClass GOOD Blui —
myClass_20230..  Wed Jul 050%... 15.3KB myClass GOOD Blut e
wClass_20230... Wed Jul 0510,  16.1KB yCl GOOD Blut
myClass_ ed Jul myClass u Ceit metadata..
myClass_20230.. Wed Jul 05 10:...  161KB myClass GoOoD Blus
myClass_20230.. Wed Jul 051 15.86 KB myClass GOoD Blut Editor path:
myClass_20230... Wed Jul0510... 15.8KB myClass GOOD Blui
PO P . e 7o) LT N . T T, ¥ ar R ] P, [NV nl.. Bl = " o

2. How to implement data acquisition

Describes how to implement a data acquisition module using Data Collector and Data Shipper into

a program.

2.1 Create New project.
1. Select [File]>[New]>[Renesas C/C++ Project]>[Renesas RX] menu.

Oitems selected

B eostudio - € studic - O X

File | Edit Source Refactor Navigate Search Project RenesasViews Run Renesas Al Window Help

| New Alt=Shift+N > Renesas C/C++ Project 5] Renesas Debug Q i ||Eocs
Open File... ¥ Makefile Project with Existing Code Renesas RA Bz Outline X =7

(3 Open Projects from File System.., I} C[C.-H Project Renesas RL78 There is no active editor that
Recent Files * [ Project.. provides an outline.
Close Editor Convert to a C/C++ Project (Adds C/C++ Nature)
Close All Editors &% Source Folder
Save Ctrl+S 5 Folder
5a f Source File

- .
Save All Cirl+Shiftes | (8] HeaderFile
Revert [% File from Template
& Class

Kl % Code Generator
Rename... F2

& Refresh fp = EEmEE=
Convert Line Delimiters To > [ Other.. Ctrl+N
Print... Crl+P

iy Import..

iy Export..
Properties Alt+Enter
Switch Workspace >
Restart
Exit s % B Console| ] Properties| @ Smart Browser | K5} Smart Manual v 8§ = 8

OTErE
Description Resource Path Location Type
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

2. Select [Renesas CC-RX C/C++ Executable Project] item.

Templates for Renesas RX Project

Renesas CC-RX C/C++ Executable Project ”
e+ PN A (/C++ Project for Renesas RX using the Renesas
CC-RX toolchain.

Renesas CC-RX C/C++ Lﬂ:rary I-J'mject
PEN A T+ + Library Project for Renesas RX using the
Renesas CC-RX toolchain,

® < Back Finish Cancel
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RX Family

Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

3. Specify Project Name.

8

Mew Renesas CC-RX Executable Project
New Renesas CC-RX Executable Project

Project name:

O x
=

RealityAlSample

Use default location

Working sets

C¥workspace¥e2studio¥RealityAlSample

Create Directory for Project

default

[] Add project to working sets

@

=

Finish

Browse...

Select...

Cancel

Push [Next] button.
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

4. Select [CK-RX65N] in Target Board.

Q st h- e*st - — [m] X
File Edit Source Refacto

| ®-®ein 4P ° o Q m | [EEe
B Project Explorer % : New Renesas CC-RX Executable Project — (8= outine =5

. . |
Select toolchain, device & debug settings There is no active editor that

provides an cutline,
There are no projects in your]

To add a project: Toolchain Settings
La 2 € OcC
= Create a new Makefile T OE @
=l directory contzining ef  Toolchain: Renesas CC-RX ~
[€] Create s new Cor G+ Toolchain Version: | v3.05.00 v
e a p .
e Manage Toolchains...
£y Import projects...
RTOS: None ~
RTOS Version:
Device Settings Configurations
Target Board: |" Create Hardware Debug Configuration
[ —©© -
Target Device: T
CPUCardR¥24T [ Create Debug Configuration
CPUCardforMCUEvaluationRX66T RX Simulatar -
Endian: | CPUCardforRSSKMotorRXEET
CloudKitRX65M _ .
Praject Type: | EnvisionKitRX&sN [ Create Release Configuration
EnvisionKitRX72N
‘GR-ROSE-RX65N B =
MCB-RX26T Type A Y § = 08
MCB-RX26T Type B P
RSKRX111 -
RSKRX113 Type
RSKRX130
RSKRX130-512KB
- RSKRX140
@/ RSKRX231 ext > Finish Cancel
RSKRX231B
————|RSKRX23T
RSKRX24T
0items selected RSKRX24U
RSKRXB4M v

Push [Finish] button to create a new project.
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

2.2 Import and setup for FIT Modules for Reality Al
1. Open Smart Configurator.

Double Click [“projectname”.scfg] in Project Explorer.

& e2studio - ¢ studio - m] *

File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas Al Window Help
Q %\l ) C/C++ | & Smart Configurator

| R AR R
{7 Project Explorer 3 = 0 = 0O |[5= outline = = 0
= ij T E There is no active editor that
w (25 RealityAlSample [HardwareDebug] prevides an cutline.

[l Includes

{54 RealityAlSample. rig]

1%| RealityAlSample HardwareDebug.laun
() Developer Assistance

=

a
‘
u]

[#] Problems | B Console X [T Properties| @ Smart Browser | ) Smart Manual =% 2f Ed" s > |

RA FSP

<

8 RealityAlSample.scfg - RealityAlSample
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

2. Add Components.

Select [Components] tab and Click [Add component] icon.

& eostudio - RealityAlSample/RealityAlSample.scfq - & studio - m] X
File Edit Navigate Search Project RenesasViews Run RenesasAl Window Help
| W Rovidr Q- Q @l 2 C/C++ | & Smart Configurator
G Pr X = B |[i5 RealityAlsample.scfg X = B |[& MCU/MPUPac X . (2) Developer Ass = 8
& g . s =
E 27§ software component configuration c| =
v £ RealityAlSample Generate Code Generate Report m = . .
[ Includes . x ks £
e fas e % B [® 3 Configure [6)
{5t RealityAlSample
|| RealityAlSample
(7) Developer Assist | Add component
A 8 C D E F
w = Startup
v & Generic |l P2 (pAz) vss [eeo wec (D |
& rbsp
5 Par PE1 P4 PB3 Pla PH1 5
4 Paz PE0 PE4 Pas Pis PH2 4
E] Ple L2 PE2 P14 P PH2 E]
2| avcco P2z | | FMED | (B3 Py v |2
1 AVSS0 | RES# XTAL EXTAL wiCL VsS 1
A 8 C D E F
< > | | Overview |Board | Clocks Sy;tempms Interrupts » legend
& Console S b | ™ B~ 9~ = O |[[2 Configuration Problems X ¥ 3 = 0O
RA FSP 0 items
~
Description Type
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

3. Download FIT modules.

—  Select [Download the latest FIT drivers and middleware] link.

&) New Component O *
Software Component Selection
Select compenent from those available in list E

Category |All w
Functicn | All g
Filter |

Components Short Mame Type Version *

£ 8-Bit Timer Code Generator 1.10.0

3 ADPCM compress/de-compress codec 5. r_s2_n Firmware Integr..  3.04

3 BLE RYZ012 Medule control functions fo... r_ryz012_rx Firmware Integr..  1.01

£ Board Support Packages. r_bsp Firmware Integr..  7.41

B8 Buses Code Generator 1.11.0

B3 Byte-based circular buffer library. r_byteg Firmware Integr.. 210

3 CAM Driver r_Can_r Firmware Integr..  5.40

£ Cellular Madule control functions for Re..  r_cellular Firmware Integr..  1.10

i TP U SO PR 1 P —x Tt P S 4 e ~

Show only latest version
Hide items that have duplicated functionality

Description

This software component generates two units (unit 0, unit 1) of an on-chip 8-bit timer (TMR) module
that comprise two 8-bit counter channels, totaling four channels.

Download the latest FIT drivers andymiddleware

Configure general settings... St

® < Back Mext > Cancel
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

—  Select Region on dialog and uncheck [Show RX Driver Package only] .

& O bt

FIT Module Download \

Select the FIT modules for download IE < 5 I

Title Document ... Rew lssueda ~ || Select Al
[] RXFamily ZMOD4410, ZMOD44...  ROTANG04.. Rewl.. 2023-07 Deselect All
[] RXFamily Clock Synchronous C..  ROTAN286.. Rew3.. 2023-06
[] RXFamily QSPI Clock Synchron...  ROTAN194.. Rewl.. 2023-06
[] RXFamily RYZ014A Cellular Mo...  RO1ANS&32.. Rewl.. 2023-05
[] RXFamily RX Driver Package Ver... RO1ANG90.. Rewl.. 2023-05
[] R family TSIP (Trusted Securel...  R20AMN0S4.. Rewl.. 2023-05
[] RXFamily F52012 Sensor Control... ROVANG04.. Rewl.. 2023-04
(] RXFamily HS400X Sensor Contr..  ROTANG44.. Rewl.. 2023-04
] RXFamily Flash Module Using Fi... RO1AMZ18.. FRews.. 2023-04 ¥
£ >
Filtered:

] Show RX Driver Package only

Module Folder Path:

| C:¥Users¥a5088905¥. eclipse¥com.renesas. platform_download¥FITModules | | Browse...

Download Cancel

Check the following FIT modules in list.

. RAI Data Collector Middleware

. RAI Data Shipper Middleware

. UART Communication Driver Interface Middleware
Push [Download] button

Confirm “End User License Agreement (Sample Code)”. If you can agree this
license, push [Accept] button.
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

— Input [rai] in Filter and select [RAI Data Shipper Middleware] item.

When select [RAI Data Shipper Middleware], Smart Configurator will automatically

import the required components.

@

Software Component Selection

Select compenent from those available in list

Category |All

Function |All

Filter | rai

Compoenents Short Mame

2 RAl Data Collector Middleware . tai data collector

Type
Elrweare loteqr

Wersion

100

Firmware Integr..

1.00

4 RAl Data Shipper Middleware R rm_rai_data_shipper_rx

Show only latest version
Hide items that have duplicated functionality

Description

Dependency : r_bsp version(s) 7.21

Dependency : rm_comms_uart_rx version(s) 1.00
Dependency : rm_rai_data_ccllector_rx version(s) 1.00
This module collects and shipping data for RAL

Download the latest FIT drivers and middleware

Configure general settings...

?\ < Back Mext =

Cancel

Push [Finish] button in New Component Dialog.
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

4. Import CRC Calculator and setup.

Data Shipper use CRC (Cyclic Redundancy Check) calculator feature. So, import FIT
module for CRC Calculator.

—  Select [Components] tab and Click [Add component] icon in Smart Configurator.

—  Select [CRC Calculator] item and push [Finish] button.

& ew Component O Y
| Software Component Selection
Select compenent from those available in list .I:l:l-
| Category |All o
Function |All w
Filter  |CRC |
Components Short Mame Type Version
B CRC Calculator Code Generator 1.11.0 I

Show only latest version
Hide items that have duplicated functionality

Description

The CRC (Cyclic Redundancy Check) calculator generates CRC codes.

; Download the latest FIT drivers and middleware

Configure general settings...

@ < Back Mext > Cancel
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RX Family

Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

—  Change [MSB] of “Bit order” for CRC Calculator.

Compene... 9 5

= Configure

W

| type filter text

¥ (= Startup
w = Generic
& rbsp
“ [~ Drivers
v [= Safety

& Config_CRC

Calculation setting

Generating polynomial CRC 8 ~
Bit order MSB )
Initial value (w00 ~

O Invert result of calculated value

Cverview | Board | Clocks | System | Components| Pins| Interrupts

e a x

%% *RealityAlSample.scfg X = B8
Software component configuration c! =

P 9 Generate Code Generate Report

@

RO1AN6975EJ0100 Rev.1.00
Jul.20.23

RENESAS

Page 14 of 38




RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

5. Import SCI/SCIF Asynchronous Mode and setup.

Data Shipper use SCI to connect to PC. So, import FIT module for SCI and change the
resource for SCI for CK-RX65N.

—  Select [Components] tab and Click [Add component] icon in Smart Configurator.

—  Select [SCI/SCIF Asynchronous] item and push [Next] button.

&) New Component O >
Software Component Selection
Select compenent from those available in list .I:lj
Category |All w
Functicn |All w
Filter |sCI
Compenents Short Name Type Version  ®
SCI Driver r sCi r Firrmware Integr..  4.80
| B sCI/sCIF Asynchronous Mode p,  Code Generator 1.12.0 I
SCI/SCIF Clock Synchrencus Mode " Code Generator 1.12.0
2 Simnnla 1 Dirivar v eri e re Eirrmurars Intanr 7 En b
Show only latest version
Hide items that have duplicated functionality
Description
This software component provides configurations for SCI(SCIF, RSCI) single(multi-processor)
asynchronous mode.
Download the latest FIT drivers and middleware
Configure general settings...
?\ < Back Mext > Cancel
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Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

RX Family
—  Change [Transmission/Reception] of “Work mode” and change [SCI5] of “Resource”
and push [Finish] button.
&) New Component O *
Add new configuration for selected component |
SCIFSCIF Asynchronous Mode
Cenfiguration name: |CDn"ig_SCI5
Work mode: ITransmissianReceptiun v
Resource: IE}CIS w
@' < Back Mext > Cancel
RO1AN6975EJ0100 Rev.1.00 Page 16 of 38
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

6. Import HS300x Sensor Middleware FIT module and import sample project to workspace.

CK-RX65N has many sensors. in this sample project use HS300x. So, import FIT module
for HS300x and import sample project.

—  Select [Components] tab and Click [Add component] icon in Smart Configurator.

—  Select [HS300x Sensor Middleware] item and push [Finish] button.

&) New Component O >
Software Component Selection
Select compenent from those available in list .I:lj

Category |All w
Functicn | All ~
Filter  |HS |
Compeonents Short Name Type Wersion
4 H5300x Sensor Middleware r_hs300x_rx Firmware Integr.. 1.22 I
HS%400x Sensor Middleware r_hs400x_rx Firmware Integr..  1.00

Show only latest version
Hide items that have duplicated functionality

Description

Dependency : r_bsp version(s) 6.21

Dependency : r_comms_i2c_rx version(s) 1.20

The H53000 FIT module controls the Renesas Electronics H5300x sensors using RIIC FIT module and/for
SCI_IC FIT module.

Download the latest FIT drivers and middleware

Configure general settings...

@ < Back Mext = Cancel
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RX Family

Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

and import sample projects] menu.

Right-button click [r_hs300x_rx] in tree of Smart Configurator and select [Download

8 eostudio - RealityAlSample/RealityAlSample.scfg - € studic

]

x

File Edit Navigate Search Project RenesasViews Run RenesasAl Window Help
Eﬁ‘]l SR N - F Q E’l R C/C++ | &% Smart Configurator
F5Pro0 x = B |[4} *RealityAlSample.scfg X =0 |[@Emx » = A
& . o =
5% W E || software component configuration |
P! 9
> 125 RealityAlSample Generate Code  Generate Report
B a2 2»
Components 23 5 [% [F [ 3p ~ Configure @
% . Property Value
[type fitter text | v B Configurations
v & Safety o # Parameter Checking System Default
& Config_CRC # Number of HS300x Sensors 1
v Cnmmuni;atmns # Data types from HS200x Sensors Humidity and Temp: P S e
@& Config 5CIs # Programming mode for HS300x sensor OFF Y IT T
(}- I riic n: # 12C Communication device No. for H5300x sensor 12C Communication
g- r_sm_u( e # Callback function for HS300x senscr deviced hs300x_user_callbac B (R el (R (k) (R
w (= Timers # pe () (e (e (e (R
‘}’rﬁcmtﬁrx # ea ) fon ) (e (o) (o) (ma
v (= Middleware
w [ Communications ween oY s | fom (oY
g; r_comms_i2c_r
sy (b ool | v s
w [ Sensors
- FR— -
E >
w [ Genenc Change version...
Q’ fm.comms.ua Remove
& rm_rai_data_cc
& rm_rai_data_sk Reset to default
“
Download and import sample projects
Overview | Board | Clocks | Sy I..j F P dadl b b Legend
& Console X = &~ %~ = B |[[& coniguration Prablems (Q Search X ] - 3 =8
No consoles to display at this time. No search results available. Start a search from the search dialog...
—  Launch [Smart Browser] view and right button click [HS300x Sample application -
Sample Code] list and select [Sample Code (import projects)]
e o X

Q Smart Browser >

SAPH DR v E =0

Device: RSF565NEH (RX65N)

1 matches (filtering)

Last updated: 2023/07/19 at 13:54:09 IST

Context Help  User's Manual Technical Update Application Notes  Tool News Notifications

Title

Document ...

I HS300x Sample application - Sample Code

I P 8B lrnn

Open
Sample Code (download)

Rew. Iss

3

2y, 1,52

I Sample Code (import projects) I

Property
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

—  Select [HS300x_RX65N_NonOS(r01an5897xx0152-
hs300/HS300x_RX65N_NonQS)] item.

& Import O >

Import Projects

Select a directory to search for existing Eclipse projects.

() Select root directony: Browse...
(®) Select archive file: C¥tmp¥Er01ans887«x0152- he300w.zi o Browse...
P P
Projects:
[] H5300x_RL78G23_MonOS_LLVM (r01an5857xx0152- hs300x/HS530 » Select All
[] HS200x_RL78G23_Non0S (r01an5897xx0152-hs300x/H5200x_RL:
[] H5300x_RX65M_Azure (r01an588Txx0152-hs300x/H5300x_RXE5N Deselect All

[ ] HS300x_R¥a5M_FreeRTOS (r01an5897xx0152-hs300x,/ H5300x_RX -
HS5300_R¥a5M_Mon(S (ri1an5857xw0152- hs300w,/ HS5300x_BXasMN_MNonO5/)
|| H5300x_FZG2L_FreeRTOS (r01an5897x0152-hs300x, HS300

[] HS300_RZG2L_MNon(OSs (ri1an5897xx0152-hs300x/HS300x_RZG2
£ >

esh

Opticns

Search for nested projects

Copy projects into workspace
[] Close newly imported projects upon completion
[ ] Hide projects that already exist in the workspace

Working sets
[ ] Add project to working sets Mew...
Working sets: Select...

0 e

RO1AN6975EJ0100 Rev.1.00 Page 19 of 38
Jul.20.23 RENESAS



RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

—  After importing the sample project, the sample project will appear in the workspace
in Project Explorer.

{8 eostudio - RealityAlSample/RealityAlSample.scfq - & studio - m] *
File Edit Navigate Search Project RenesasViews Run RenesasAl Window Help
| T - -idE - G- Q @l R C/C++ | &% Smart Configurator
I¥5 Project Explorer 3 = B |[#} RealityAlSample.scig X = 0 |[gEgmx 2 = 8
== g . o =
— Software component configuration | =
v IS H5300x_RX6SN_NonQS Generate Code Generate Report m = D hs
) Includes L = 2 o
8 s Components iy 5 = = Configure ()
(= HardwareDebug -
= " B .
|2 HS300x_RX6SN_NonQS.rcpe roperty
& HS200x_RXESN_NonOS.scfg type filter text | + & Configurations
|%] H5200x_RX65N_Non(S HardwareDebug.laur] & Config CRC & # Parameter Checking
- :a Developer Assistance + = Communications # Number of HS300x Sensors
= RealityAlSample & Config_5CI5 # Data types from H5300x Sensors
%—- I riic r; # Programming mode for H5300x sensor
& ©sci e m # 12C Communication device No. for H5300x sensor
v B Timers # Callback function for H5300x sensor deviced N 9-rYT Y
g» r_cmt_rx #
; # Callback function for Hoanne censor cevicer | | {[+] (0 6 =D 69 6 & |-
w = Middleware
v = Communications | | | ]
%" r_comms_i2c_m 2| moc (B pn (RN B e |
v [ Sensors - e i &
%" r_hs300x_rx o
v (= Generic < kd
& rm_comms_uart_rx
.(" rm_rai_data_collect
.(" rm_rai_data_shippe -
< >
< > || Overview | Board | Clocks | System | Components | Pins | Interrupts b Llegend
& Console X S BE&| = % = = B |[[2 configuration Prablems | 4 Search | @ Smart Browser X = 0
Smart Configurator Output & o ‘ % S%‘ §
We4e20001: The configuration r_bsp has been unloaded because the module ~
- Device: RSF51101A(RX110) Last updated: 2023/07/17 at 15:39:43 JST
< > Nofifications r

2.3 Import sample project for Data Collector and Data Shipper

A sample project created using the steps described in this application note is attached with this
application note. Please import by the following steps. Please refer to the imported project as
necessary.

. Right-button click [rm_rai_data_shipper_rx] in tree of Smart Configurator and select
[Download and import sample projects] menu.

. Launch [Smart Browser] view and right button click [RX Family Reality Al Data Acquisition
Module (Data Collector / Data Shipper) - Sample Code] list and select [Sample Code(import
projects)] menu.

& _ O ¥
(&% Smart Browser e o = A | g = g
Device: RSFSESMNEH (RXESN) Last updated: 2023/07/19 at 13:54:09 IST

ContextHelp  User's Manual Technical Update Application Notes Tool News  Notifications

1 matches (filtering)

Title Document... Rew Iss|

|| RX Family Reality Al Data Acquisition Module { Data Collecto 1 .
Open

Sample Code (download)

a

4y, 1,52 20

I Sample Code (import projects) |, I
Property ;

- Select [RealityAl_DataAcquisition_ RX65N_NonOS] item
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RX Family

Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

2.4 Setup BSP
Change Heap size.

. Change the property of [r_bsp] as follows:

Property  Value
Heap size 0x2000

8 o x
5% RealityAlSample.scfg X =g
e =
Software component configuration o] =]
P 9 Generate Code Generate Report
Components =y 25 =] 2p »  Configure @
e Property Value ~
‘?,-pe"ll'.er'.e&:'. | w # Configurations
v = Startup ~ # User stack setting 2 stacks
v (= Generic # User stack size 01000
~ | # ot ack dize (Ao
v = Driversﬁ # Heapsize Ox2000 I
v (= DMA # [Initializes Cinput and output library functions Enable
%" r dtc m # Enable user stdic charget function Use BSP charget() function
v (= Safety #
*" Config_CRC ## Enable user stdio charput function Use BSP charput() function
w (= Communications #
* Cenfig SCI5 # Processor Mode Stay in Supervisor mode
& rric # IDcode 1 OuFFFFFFFE
& reciiic # IDcode OxFFFFFFFF
v Timers # IDcode3 OxFFFFEFFF
B romt e # 1Dcode4 OxFFFFFFFF "
w (2= Middleware Macro definition: BSP_CFG_HEAP_BYTES
w = Communications Heap size - . .
q; r comms i2C NOTE: This setting is available only when using CCRX and GNUC.
v (= Sensors b
< >
Overview |Board | Clocks | System | Components | Pins| Interrupts
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

2.5 Setup Sensor (HS300x)

Add source code for sending data to PC using Data Shipper into HS300x sample code. Copy and
rename sample source file to src folder.

Copy File
From RealityAl_DataAcquisition_RX65N_NonOS/sample/RX_HS300X.c.sample
To “Project Folder”/src/RX_HS300X.c
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RX Family

2.5.1 Setup I12C for HS300x
. Change the property of [r_comms_i2c_rx] as follows:

Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

Value

RIIC

0x44
rm_hs300x_callbackO

Property

I2C Driver Type for 12C Shared Bus0

Slave address for 12C Communication Device0O
Callback function for 1I2C Communication Device0O

{5 *RealityAlSample.scig

Software component configuration

[+
E

Components By g =

Configure

= 0
&l =)
Generate Code Generate Report

@

iy

Value ~

|'.',-|:.e filter text

12C Driver Type for 12C Shared Bus0

RIIC 1

@ rbsp
~ = Drivers
w (= DMA
9 r_dtc_rx
v = Safety
& Config_CRC
w [= Communications
& Config_SCI5
a» r_riic_rx
%" r_sci_iic_r«
w = Timers
a'—' r_cmt_rx
~ = Middleware
s = Communications

w [= Generic -~

Channel Mo. for [2C Shared Bus0

AR R RO

%v" r_comms_i2c_rx I
w [= Sensors

2&" r_hs300x_r
w [= Generic

a: rm_comms_uart_nc

s rm rai data collector rx

Owerview | Board | Clocks | System | Components | Pins | Interrupts

Macro definition: COMMS _12C_CFG_BUS0 DRIVER TYPE
Set the driver type (see below) to be used for each 12C Shared Bus.

- When using RX FIT RIIC, set this to "RX FIT RIIC".
- When using RX FIT SCI IIC, set this to "RX FIT SCI 1",

{5 *RealityAlSample.scig

Software component configuration

[
E1ES

Components By g =

|71'PE filter text

& rbsp
~ [= Drivers
v = DMA
% r_dtc_mx
w [= Safety
& Config CRC
w [= Communications
& Config_sCIs
3 r_riic_rx
a‘-’ r_sci_iic_n
w = Timers
%" r_cmt_rx
 [= Middleware
w = Communications

v (= Generic ~

Configure

= 0

%l =]
Generate Code Generate Report

@

EEEEELEE E L]

# 12C Shared Bus No. for I2C Communication Device

Value e

12C Shared BusO

# Slave address for [2C Communication Device0

Ox44 |

7bit address mode

# Address mode for 12C Communication Deviced ess
iE Callback function for [2C Communication DeviceQ rm_hs300x cﬂbackd | |

Al H R

%" r_comms_i2c_rx I
w = Sensors

a'—' r_hs300x_rx
w [= Generic

B rm_comms_uart_rx

& rm rai data collector e

Overview | Board | Clacks | System | Components| Pins | Interrupts

Macro definition: COMMS_I2C_CFG_DEVICEO_CALLBACK
Specify the Callback functicn name of the [2C Communication Device0,

RO1AN6975EJ0100 Rev.1.00
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RX Family

Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

. Change the property of [r_sci_iic_rx] as follows:

Property

MCU supported channels for CHO Supported

Value

{74 *RealityAlSample.scig X
Software comp config

Components pag gy =] 3» v Configure

g

Generate Code Generate Report

] X

=

=

@

‘ type filter text |

v [= Startup -~
w = Generic

Property
~ Cenfiguraticns

Value

lnclude

~

# MCU supported channels for CHO

Supported

= =

& rbsp
~ = Drivers
w = DMA
ﬁ» r_dtc_r
v (= Safety
& Config_CRC
w = Communications
& Config_5CI5
= rriic_r
E" r_sci_iic_mx I

w [ = Timers

?.v r_cmt_m

5 MU supported Thanners Tor L
# MCU supported channels for CH2
# MCU supported channels for CH2
# MCU supported channels for CH4
# MCU supported channels for CHS
# MCU supported channels for CH6
# MCU supported channels for CH7
# MCU supported channels for CH8
# MCU supported channels for CH2
# MCU supported channels for CH10
# MCU supported channels for CH11
# MCU supported channels for CH12

Not supported
Mot supported
Mot supported
Not supported
Not supported
Not supported
Mot supported
Mot supported
Mot supported
Mot supported
Not supported
Not supported

v = Middleware
w = Communications
Q. r_comms_i2c_rx

v [ Sensors &
< >

Overview |Board | Clocks | System | Components | Pins | Interrupts

2.6 Setup Data Collector
. Change the property of [rm_rai_data_collector_rx] as follows:

Property
Snapshot Mode Channel 0 Name

Value
Temperature

Snapshot Mode Channel 0 Data Type 8-bit Unsigned

Snapshot Mode Channel 1 Name

Humidity

Snapshot Mode Channel 1 Data Type 8-bit Unsigned

Snapshot Mode Channels 2

Snapshot Mode Count
Timer Frequency Hz
Timer Priority Level

RO1AN6975EJ0100 Rev.1.00
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

e [m] X

5% *RealityAlSample.scfg X =

Software component configuration
P 9 Generate Code  Generate Report

Components D ey | =5 # 3p v Configure @
=
s Property Value &
|b,'pe filter text | # Snapshot Mode Channel 0 Name Temperature L\,
& Config CRC - # Snapshot Mode Channel 0 Data Type &-bit Unsigned
vE CDmmum;atiDns # Snapshot Mode Channel 1 Name Humidity
‘," Config_5CI5 # Snapshot Mode Channel 1 Data Type 8-bit Unsigned
- # Snapshot Mode Channel 2 Name dc0_snapshot_ch2
# Snapshot Mode Channel 2 Data Type &-bit Signed
v @& Timers # Snapshot Mode Channel 2 Name dc0_snapshot_ch3
‘}-" rcmt # Snapshot Mode Channel 3 Data Type &-bit Signed
vE Middleware # Snapshot Mode Channel 4 Name dc0_snapshot_ch4
v (= Communications # Snapshot Mode Channel 4 Data Type &-bit Signed
g- r comms i2c # Snapshot Mode Channel 5 Name dc0 snapshot_chs
vE Sen;ors - # Snapshot Mode Channel 5 Data Type 8-bit Signed v
9 r_hs300x_r < >
v = Generic Macro definition: RM_RAI_DATA_COLLECTOR_CFG_DCD_SMAPSHOT_CHANNELD NAME
%" rm_comms_uart_re ‘Channel name.
W rm_rai_data_collector_nc ||
& rm_rai_data_shipper_rx v
Overview | Board |Clocks | System | Companents| Pins| Interrupts|
e [m] X
5% *RealityAlSample.scfg X =8
e =)

Software component configuration
P 9 Generate Code  Generate Report

Components f o 1% B @ 3 v Configure o
=
e Property Value A
|f‘:’PE filter text | # Snapshot Mode Channel 4 Data Type 8-bit Signed
& Config CRC - # Snapshot Mode Channel 5 Name dcf_snapshot_ch3
+ (= Communications # Snapshot Mode Channel 5 Data Type 8-bit Signed
& Config 515 # Snapshot Mode Channel & Name dcf_snapshot_ch&
e," T_riic_rx # Snapshot Mode Channel & Data Type 8-bit Signed
q," r_sci_iic_rx # Snapshot Mode Channel 7 Name dc snapshot_ch7
v = Timers 2 _Snapshot Mode Channel 7 Data Type B-bit Signed
%,." rcmt_n # Snapshot Mode Channels 2 %l
v (= Middleware # Snapshot Mode Count 1
v [= Communications 4 _Timer Channel [l
%‘ r_comms_iZc_n # Timer Frequency Hz 100 I
v &= Sensors # Timer Priority Level 14 .
O r_hs300x_r < >
v (= Generic Macro definition: RM_RAI_DATA_COLLECTOR_CFG_DCO_SNAPSHOT_CHANNELO_NAME
9 rm_comms uart rc (Channel name.
W rm_rai_data_collector_rx 1
& rm_rai_data_shipper_rx v

Overview | Board |Clocks | System | Companents| Pins| Interrupts|
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

2.6.1 Setup DTC
. Change the property of [r_dtc_rx] as follows:

Property Value
Transfer Data Read Skip Disable transfer data read Skip
DMAC FIT check DMAC FIT module is not used with DTC FIT module
e’ O
{5 *RealityAlSamplesscig % =g
Software component configuration ! =
P g9 Generate Code Generate Report
Components  puy =] 2. = Configure @
L Property Value
|7,-|:.e filter text ‘ ~ & Configurations
v (= Startup Py # Parameter check System Default : .
v (= Generic # DTCER control Clear all DTCER registers in R_DTC_Open()
& rbsp #_Address mode Full address mode
v Drivers_ # Transfer Data Read Skip Disable transfer data read Skip
v (= DMA # DMACFIT check DMAC FIT module is not used with DTC FIT module. |
% r_dtc_r I # Sequence transfer Sequence transfer not used
~ (= Safety
& Config_CRC
~ = Communications
& Config_SCIs
% r_riic_rx
% r_sci_iic_m
~ = Timers
% r_cmi_rx
~ = Middleware
+ (= Communications
3 ¢ comms iZc e Macro definition: DTC_CFG_USE_DMAC_FIT_MODULE
- - SPECIFY WHETHER THE DMAC FIT MODULE IS USED WITH DTC FIT MODULE
Ve 5_?”50’5 - DTC_DISABLE : DMAC FIT module is not used with DTC FIT medule.
3 r_hs300x_rx - DTC_ENABLE : DMAC FIT module is used with DTC FIT module.
w [= Generic
f‘ rm_comms_uart_x W
Overview  Board | Clocks | System | Components| Pins | Interrupts
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RX Family

Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

2.7 Setup Data Shipper

. Change the property of [rm_rai_data_shipper_rx] as follows:

Property Value
Frame Rate Divider 50
a I
{5} RealityAlSample.scfg 3 =g
Software component configuration %l =
Generate Code  Generate Report
Components 2y e = 2L~ Configure @
W n Property Value
type filter text | w Cenfigurations
v = Safety Py # Parameter check LIse system default
f.- Config_CRC # Frame Rate Divider 50
v @ Communications 7 Callback ral_data_shipper0_callback
'r'- Config_SCIS # UART Communication device No. UART Communication Deviced
& rriic_rx # CRC Enabled
1} _sci_jic_rx # Component name of CRC Config_CRC
v (= Timers
‘} r_cmi_rx

v = Middleware
w = Communications
ﬁr r_comms_i2c_rx
w [2= Sensors

<

ﬁr r_hs300x_rx
w = Generic
ﬂr rm_comms_uart_rx
f“ rm_rai_data_collector_rx
o rm_rai_data_shipper_m I

L

Overview | Board | Clocks | System | Components| Pins | Interrupts

Macro definition: RM_RAI_DATA_SHIPPER_CFG_FRAME_RATE_DIVIDER

Skip write requests.
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RX Family

2.7.1 Setup UART for Data Shipper
. Change the property of [rm_comms_uart_rx] as follows:

Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

Property Value

Component name of UART Config_SCI5

Channel of SCI UART 5

Callback function for UART Communication DeviceO rm_rai_data_shipper_callbackO

8 o x
{5 *RealityAlSample.scig 3 =08
o= =
Software component configuration cl
P 9 Generate Code  Generate Report
Components  [ug g3 (= 2 = Configure @
i Property Value ~
“ | # [TX] Bus Lock Operation Supporting with RTOS Enabled
& rbsp =~ # [RX] Blocking Operation Supporting with RTOS Enabled
v Drivers_ # 17 Bus Lock operation Supporting with RTOS Enabled
v = DMA # Compenent Name of UART Config_sCI5
a_'- r dtc_me # Channel No. of SCI UART 5
v G Safety F [UANT Shared BusD) Clock soUrce CLRINT
& C;n‘\q CRC # [UART Shared Bus0] Data Size 8-bit
v CD\T\\T\UWEEtiDI‘IS # [UART Shared Bus0] Parity On/Off Disabled
f_ Config_SCI5 # [UART Shared Bus0] Parity Type EVEN parity
a'-- ' riic n: # [UART Shared Bus0] Stop bits 1-bit
a_'- r_sci_iic e # [UART Shared Bus0] PCLK Frequency [MHz] 60
i Tim;rs - # [UART Shared Bus0] Bit Rate [bps] 115200
ar" r_cmit_rx #
v = Middleware # _[UART Communication Deviced] UART Shared Bus No. UART Shared Bus0
v (& Communications # [UART Communication Device0] Callback Function rm_rai_data_shipper_callbackd I
ar" r_comms_i2c_mn # v
w [ Sensors
%" r_hs300x_rx
v L= Generic
f rm_comms_uart_rx I
% rm_rai_data_collector_n
a—" rm_rai_data_shipper_rx w
Overview | Board | Clocks | System Components | Pins| Interrupts
. push [Generate Code] button.
a8 I
{5; *RealityAlSample.scig X =
&l =

Software component configuration
P 9 Generate Code [Generate Report

Overview | Board | Clocks | System | Companents | Pins | Interrupts

TS 29 edy % = 3p v Configure [}
bl Property Value -
type filter text | # Snapshot Mode Channel 4 Data Type 8-bit Signed
".' Config CRC o # Snapshot Mode Channel 5 Name dc0_snapshot_chs
+ = Communications # Snapshot Mode Channel 5 Data Type 8-bit Signed
& Config 5CI5 # Snapshot Mode Channel 6 Name dc0_snapshot_ché
g; T_riic_re # Snapshot Mode Channel 6 Data Type 8-bit Signed
ﬁ," r_sci_iic_n # Snapshot Mode Channel 7 Name dc snapshot_ch7
v = Timers # Snapshot Mode Channel 7 Data Type 8-bit Signed
ﬁ," rcmt_n # Snapshot Mode Channels 2 L\\)
~ (= Middleware # Snapshot Mode Count 1
w (= Communications # Timer Channel 0
9 v comms_i2c_r # Timer Frequency Hz 100
~ (= Sensors # Timer Priority Level 14 v
9?' r_hs300%_n < s
v (= Generic Macro definition: RWM_RAI_DATA_COLLECTOR_CFG_DCO_SMAPSHOT_CHANNELO MAME
%»" rm_comms_uart_re Channel name.
& rm_rai_data_collector_n
ﬂ: rm_rai_data_shipper_r« v
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

2.9 Modify source code.
Add process of main function and add callback function to SCI.

. Replace and rename sample source file to src folder.

Replace File
From RealityAl_DataAcquisition_RX65N_NonOS/sample/RealityAlSample.c.sample

To “Project Folder”/src/RealityAlSample.c
From RealityAl_DataAcquisition_RX65N_NonOS /sample/Config_SCI5_user.c.sample
To “Project Folder”/src/smc_gen/Config_SCI5/Config_SCI5_user.c

2.10 Build project.
. Right-button click “Project Name” in Project Explorer and select [Build Project] menu.

5§ Project Explorer > = 0 ﬁ Reality Al Data Storage Tool
& 8
BS YV § Software component cc
o5 HS300x RXE5N_NonOS
v == RealityAlSample™* * =~ * |
it Includes s *
w [ src Go Into
= smc_gen i i
O Mew Wind
[& RealityAls: pen in MNew Window |
(= Output Show In Alt+5hift+W »
e Copy Ctr+C
5o RealityAlSamg ) .
[¥] RealityAlSamg = S
{7) Developer As: K Delete Delete
Source H]
Move...
Rename... F2
fag Import.
&g Export.
| BuildProject [
Clean Project
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

3. How to get sensor data from evaluation board

3.1 Setup Reality Al Data Storage Tool

1. Install Reality Al Data Storage Tool.
. Select [Renesas View]>[Renesas Software Installer] in e2 studio.

Run Renesas Al W

CfC++ »
| Code Generator >
Debug *
: Partner O5 >
Pin Configurator ]
Renesas Al >
Renesas QE ¥
Smart Configurator »
Solution Toolkit ¥
Tracing »

I'.*'v; Renesas Software Inslallern I

. Select [Renesas Al] and push [Next] button.
. Check [Reality Al Data Storage Tool] and push [Finish] button.

2. Launch Reality Al Data Storage Tool
. Select [Renesas Al]>[Show View]>[Reality Al Data Storage Tool] menu.

Window Help
&= Reality Al Authentication | Hg) C/C++ = Smart Configurator

Delete selected e studio project from Reality Al ToolsE O .
proy ¥ o= Qutline = B
Link to Reality Al Tools® project . i i
Ul Tharaic ma artiye editor that
Corrr § e A B . ]
Sync to Reality Al Tools 0 “ Hine
Download classifier from Reality Al Tools® = =

I Show View -] ﬁ Reality Al Data Storage Tool ; I
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

3. Select Project
. Select [*Project Name”] combo box.

& ] *
B= Reality Al Data Storage Toal X = 0
Project: | RealityAlSample |
Status Settings
,, No data
b Moda Data connection... Data file settings... View data structure...

Data capture Signal view

Frame size: ch Mame

Number of 256 =

frames per file: e

1 Unlimited
Instance ID:
a : myClass w
a5 name (®) Auto scale view
Start new capture () Fixed scale view 100
(® Live view () File review 0 samples
Manage capture data files
Data file group Data file Create date Size Class name Refresh
Select all data
Copy data to group
Delete...
Edit metadata...
v
4. Get data structure information from Smart Configurator
. Push [View data structure] button in Reality Al Data Storage Tool.
. Push [Import settings from Smart Configurator] button.
Data structure *
Data structure: I Import settings from Smart Configuhratorl

ch Name Format
1 Temperature int8
2 Humidity intg

Close
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RX Family

Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

4. Get connection settings from Smart Configurator
. Push [Data connection] button in Reality Al Data Storage Tool.

. Push [Import settings from Smart Configurator] button.

Cennection settings

x

I Import settings from Smart Configurator I

L
(® UART

COM port: w

Baudrate: 115200 e

Data length: | 8bit w

Parity: Mone w

Stop bit: 1bit w

CR/IP
P Address:
Connect Close
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

3.2 Modify debugger settings.
. Right-button click “Project Name” in Project Explorer and select [Properties] menu.

. Select [Run/Debug Settings] tree and select [RealityAlSample HardwareDebug] item and
push [Edit] button.

| @B oropertics for RealityAlsam O
| type filter text | Run/Debug Settings - v &
Resource
Builders Thlis iraEdge allows you to manage launch configurations associated with the currently
C/C++ Build selected resource.
C/C++ General Launch configurations for 'RealityAlSample’:
PrDJ.ECt Natures [c7] RealityAlSample HardwareDebug I New...
Project References
Refactoring History Duplicate
Renesas OF
I Run/Debug Seﬂingsl I Edit... L,
)
Taslk Ta.gs Delete
Validation
Restore Defaults Apply

@' Apply and Close Cancel
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

. Select [Debugger] tab and Change “Power Target From The Emulator (MAX 200mA)” to
[Yes].

& Edit Configuration O ¥

Edit launch configuration properties
€3 [Main]: Program does not exist

Mame: | RealityAlSample HardwareDebug |

Mainl % Debuggerli Startup| E_/ Suurcel = Cummun|

Debug hardware: | E2 Lite (RX) ~ | Target Device: | RSFSBSME

GDB Settings Cennection Settings - Debug Tool Settings

w Clock ~
Main Cleck Source EXTAL v
Extal Frequency[MHz] 24
Operating Frequency [MHz] 120.000
Permit Clock Source Change On Writing Internal Flash Memory Yes "
w Connection with Target Board
Emulator [Auto)
Connection Type Fine W
IMag Clock Frequency[MHz] 6,00
Fine Baud Rate[Mbps] 1.50 ]
Hot Plug No v
v Power

Power Target From The Emulator (MAX 200mA) [¥] I

~ CPU QOperating Mode

Register Setting Single Chip v

Mode pin Single-chip mode

Channe startun hank Mo ~
Rewvert Apply

® G
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

3.3 Connect Evaluation Board and PC
. Connect Evaluation Board and PC via USB.

. For Connection details, please refer CK-RX65N manual. The Manual is available on
Renesas Web.

OUTDOOR  INOOOR BARCMETRIC TEWP &
A01 At PRESSURE” HUMIDITY

! C ‘.‘,. .g U1 AREF
- Givi . GND

o
|

A

j

& [ iy e
g

eX1022-001

3.4 [Execute program.
. Right-button click “Project Name” in Project Explorer.
. Select [Debug As]>[Debug Configuration] menu.
. Select [“Project Name” HardwareDebug] tree and push [Debug] button.

a Debug Configurations

Create, ge, and run fig
R B Y- Name: | RealityAlSample HardwareDebug |
|t‘,’pe filter text | Main | E<3 Debquer| [= Starlup‘ B SDUKE‘ = Cummun|
C/C++ Application Py
C/C++ Remote Application
5 EASE Script |Rea|\lyAISampIE Browse...
‘GDB Hardware Debugging CfC++ Application:
[E¥] GDB Simulator Debugging (RHES0) [HardwareDebug/RealityAlSample:x
R Launch Group
v [c7] Renesas GDB Hardware Debugging Variables... Search Project.. Browse...
H$300«_RX&5N_NonOS HardwareDebug Build (if required) before launching
|c *| RealityAl DataAcguisition RX65N_NonOS H:
[c7] RealityAlSample HardwareDebug Build Configuration: | Select Automatically ~
[c 9 Renesas Simulator Debugging (KX, KL7E)
gamnd (O Enable auto build () Disable auto build
(®) Use workspace settings Configure Workspace Settings...
< >
. Revert Apply
Filter matched 11 of 13 items

@
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RX Family Reality Al Data Acquisition Module (Data Collector / Data Shipper) — Sample Code

. Push [Resume] icon on toolbar.

File Edit Source Refactor Mavigate Search Project Renesas Views Run  Renesa

(B Q- u[PluEz e B R Qi

3.5 Get sensor data.

. Push [Data connection] button in Reality Al Data Storage Tool.
. Select [COM port] connecting CK-RX65N and PC and push [Connect] button.

>
Import settings from Smart Configurator
(®) UART
COM port |COM4 ~
Baudrate: 115200 w
Data length: | 8bit ~
Parity: Mone ~
Stop bit: 1bit w
CP/IP
IP Address:
. b3
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When sensor data is acquired, a signal appears on the Reality Al Data Storage Tool view. For
the operation of Reality Al Data Storage Tool, refer to the help.

& | x
E= Reality Al Data Storage Tool X = B
Project: | RealityAlSample v| =
Status Settings
Receiving data...
V_// J Data connection... Data file settings... e
+ 1y Data errar
Data capture Signal view
Frame size: 2x50 Ch Mame
:\Iumber of - . Temperature
rames per file: -
[ Unlimited Humidity
Class name:
() Auto scale view
Start new capture (®) Fixed scale view
(®) Live view () File review 50 samples
Manage capture data files
Data file group Data file Create date Size Class name Refresh
metadata.csv myClass_20230... WedJul1914... 27KB myClass Select all data
myClass_20230.. WedJul1914... 27KB myClass
Copy data to group...
Delete... N
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between V. (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-
evaluation test for the given product.



Notice

1.

10.

11.

12.

13.
14.

(Notel)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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